Description

Simple Building
Slab Design

For LUSAS version: 21.1
For software product(s): | LUSAS Civil & Structural or LUSAS Bridge.
With product option(s): | RC Slab Design

Note: The example as written exceeds the limits of the LUSAS Teaching and
Training Version. However, by not increasing the default mesh density to 8 divisions
per line (where shown) the analysis can be run using a default of 4 divisions per line.

Description

Four panels of a concrete slab
supported by a wall, columns and a
lift shaft are to be analysed, with
reinforcement areas computed for
bending moment only. Shear and
displacement checks need to be
carried out separately. The geometry
of the slab is as shown.

The slab is subjected to self-weight
and a live load.

The units of the analysis are N, m,
kg, s, C throughout.

Objective

O To produce utilisation plots
under ultimate loads and
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check the locations of cracking under service loads
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2D, Plate Elements, Slab Design, Holes, Reinforcement, Wood-Armer, RC Design, Steel
Area, Load Combinations, Smart Combinations, SLS, ULS, Beneficial, Adverse, Cracking
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Associated Files

Associated files can be downloaded from the user area of the LUSAS website.

U slab_design_modelling.lvb carries out the modelling of this example.

Running LUSAS Modeller

For details of how to run LUSAS Modeller, see the heading Running LUSAS
Modeller in the Introduction to LUSAS Worked Examples document.

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command
File>New to start a new model file. Modeller will prompt for any unsaved data and
display the New Model dialog.

Creating a new model

o Enter the file name as Slab_Design

e Enter a file path for the working folder.

e Set the Analysis type to be Structural

e Set the Analysis Category to be 2D Grillage/Plate

o Select model units of N,m,kg,s,C

e Ensure the timescale units are Seconds

o Select the Startup template None from those available in the drop-down list.
o Enter the title as Slab Design Example

e Leave Layout grid set to None and click the OK button.

Note. The Analysis category determines which elements will be available for
modelling. Here we are only interested in the out-of-plane bending effects in a flat slab
and therefore we can approximate this behaviour with 2D plate elements.

Note. Save the model regularly as the example progresses. Use the Undo button to
correct any mistakes made since the last save was done.




Modelling

Feature Geometry
|G|e§;fig > _| De-select the 3 Columns grid style check box and
“[ByCoords..  enter coordinates of (0, 0), to define the lower left-
hand area of slab, and using the Tab key to move to
the next entry field enter coordinates of (6, 0), (6, 6)

and (0, 6).

e With all the coordinates entered click the OK
button to create a surface.

e Select the newly created Surface.

|Gf§;22 S M Copy the selected surface with an X translation of
[Copy... 6.
e Click the OK button to create the new Surface.
e Use Ctrl + A keys together to select the whole
model.
|G|e$fzg = M Copy the selected surfaces with a Y translation of ‘
| Copy... 6. L
e C(Click the OK button to define two new Surfaces.
Defining a Hole in a Slab
Next, a hole representing the lift shaft needs to be defined. This is done by first creating
a surface representing the extent of the lift shaft and then selecting both the surrounding
and inner surface to define the hole.
G t .
| |e§$fzoz > _| Enter coordinates of (2, 2), (4, 2), (4, 4) and (2,
|By Coords... 4) and click OK to define the extent of the hole.
e Select the lower left Surface and then the Surface
representing the lift shaft. (Use the Shift key to
pick the second Surface to add to the selection)
| Geometry e Ensure Delete geometry defining holes is
|% selected A new singular Surface will be created. L
oles >
(Create  This new surface containing the hole can be seen / i
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Model Properties...

| Attributes

Mesh >
Surface...

| Attributes

Mesh >
Line...

Simple Building Slab Design

checked by clicking in a blank part of the View Window and then re-selecting the
lower-left hand surface.

Note. It is normally good practice to ensure that the orientation of surface axes (and
hence mesh element orientation) is consistent throughout the model. However, plate
elements, as used in this example, produce results based upon global axes and as such
ignore inconsistent element axes.

Meshing

By default lines normally have 4 mesh divisions per line. For this example, and to give
greater accuracy, 8 divisions per line will be used.

Note. If you are using the Teaching and Training version this default value should be
left unaltered to create a surface element mesh within the limit available. This will give
a coarser mesh and correspondingly less accurate results will be obtained.

e Select the Meshing tab and set the default number of divisions to 8 and click the
OK button.

e Select the element type as Thick Plate, the element shape as Triangle and the
interpolation order as Quadratic. Select an Irregular mesh and ensure the
Element size is deselected. This forces the number of default line mesh divisions to
be used when meshing the surfaces. Enter the attribute name as Thick Plate and
click the OK button.

e With the whole model selected drag and drg

the mesh attribute Thick Plate from the
Treeview onto the selected Surfaces

In the vicinity of the lift core less elements are
required.

e Select the element type as None and enter the
Number of divisions as 4. Enter the attribute
name as Divisions=4 and the OK button

o Select the 4 lines defining the lift core and drag ...
and drop the line mesh attribute Divisions=4

from the A Treeview onto the selected Lines.

In this manner the mesh density on slabs can be varied according to the levels of detail
required.




| Attributes

Modelling

| Geometric
|Surface...

| Attributes

| Material

frame / slab

| Attributes

Concrete (RC

design)...

| Support...

Geometric Properties

Enter a thickness of 0.25. Enter the attribute name as Thickness 250mm and click
the OK button.

With the whole model selected drag and drop the geometric attribute Thickness

250mm from the &% Treeview onto the selected Surfaces. Click OK to assign to the
selected features for Analysis 1.

Geometric properties are visualised by default.

ll Select the fleshing on/off button to turn-off the geometric visualisation.

Material Properties

On the RC Material dialog ensure that Country is set to Europe and Design code is
set to EN1992.

On the drop list for Concrete section select New.
On the dialog that appears select grade C40/50 and click OK.
On the RC Material dialog for the drop list for Reinforcement select New.

On the dialog that appears select grade 500B and click OK. Click OK on the RC
Material dialog.

Select the whole model and drag and drop the material attribute Matl (EN1992)
from the & Treeview onto the selected Surfaces.

Supports

Select Fixed for Translation in Z and enter the
attribute name Fixed in Z and click OK. ﬁg:ﬁg tahnedse

assign Fixed in Z

For clarity the mesh layer is not shown on these

diagrams. ﬁ % &
Select the 6 points where the columns are located. . | .
Assign the supports by dragging and dropping the
support attribute Fixed in Z from the . l] % &
Treeview and assign to Points for All analysis ’

loadcases by clicking the OK button.




| Attributes

Loading...

| Attributes

Loading...

Simple Building Slab Design

e Select the 2 Lines representing the line support
and drag and drop the support attribute Fixed in

Z from the 8% Treeview and assign to Lines for
All analysis loadcases by clicking the OK
button.

e Select only the top, bottom and left-hand lines
defining the lift shaft and drag and drop the

support attribute Fixed in Z from the
Treeview and assign to Lines for All analysis
loadcases by clicking the OK button.

@l Select the isometric view
button to check that all supports
have been assigned correctly.

£ Wit Click this part of the

status bar to view the model from
the Z direction (plan view) again.

Loading

I

Select these 2
Lines and assign
Fixed in Z

E:

Select these 3
Lines and-assign
Fixed in Z

e Select Displacement, velocity, acceleration, body force, then Body force and

click Next.

e Enter an acceleration of -9.81 in the Z direction.

o Enter an attribute name of Self Weight and click the Finish button.

o Select Distributed loads, then Global Distributed and click Next.

o Select the Per unit area option.

e FEnter -3000 in the Z Direction.

o Enter the attribute name as Imposed Load 3kN/m2 and click the Finish button.

Now the dead and live loading needs to be assigned.

e In the Analyses (L) Treeview, right click on Loadcase 1, select the Rename option

and change the loadcase name to Permanent




| File

Running the Analysis

|Save

e With the whole model selected, assign the
dead loading by dragging and dropping
the attribute Self Weight from the
Treeview onto the selection. The loading
assignment dialog will be displayed.
Select the Single Loadcase option, the
analysis Analysis 1 and loadcase
Permanent, then click the OK button.
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o With the whole model still selected, drag
and drop the dataset Imposed Load
3kN/m2 from the € Treeview onto the
selection, accepting all defaults, and
change the loadcase name to Variable
and click the OK button.
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Saving the model

El Save the model file.

Running the Analysis

&)

With the model loaded:

El Select the Solve Now button from the toolbar and click OK to run the analysis.

A LUSAS Datafile will be created from the model information. LUSAS Solver uses
this datafile to perform the analysis.

If the analysis is successful...
Analysis loadcase results are added to the (X Treeview.
In addition, these files will be created in the LUSASFiles32\<model name> folder:

U slab_design.out this output file contains details of model data, assigned
attributes and selected statistics of the analysis.

O slab_design.mys this is the LUSAS results file which is loaded
automatically into the (E) Treeview to allow results processing to take place.

If the analysis fails...

If the analysis fails, information relating to the nature of the error encountered can be
written to an output file in addition to the text output window. Any errors listed in the




| File
[New...
| File
| Script >
| Run Script...

Simple Building Slab Design

text output window should be corrected in LUSAS Modeller before saving the model
and re-running the analysis.

Rebuilding a Model

If it proves impossible for you to correct the errors reported a file is provided to enable
you to re-create the model from scratch and run an analysis successfully. You may
download this file from the user area of the LUSAS website.

U slab_design_modelling.lvb carries out the modelling of the example.

Q‘ Start a new model file. If an existing model is open Modeller will prompt for
unsaved data to be saved before opening the new file.

o Enter the file name as Slab Design
e Use the default User-defined working folder.
e Ensure an Analysis type of 2D Inplane is set.

e C(Click the OK button.

Note. There is no need to enter any other new model details when a script is run to
build a model, since the contents of the script will overwrite any other settings made.

e To recreate the model, select the file slab_design modelling.lvb that was
downloaded and placed in a folder of your choosing.

;| Solve the model to generate the results.

Viewing the Resulits

Analysis loadcase results are present in the () Treeview and loadcase results for the
last solved loadcase are set to be active by default.

o In the = Treeview, turn off the display of the Attributes layer.

o In the "2 Treeview right-click on results loadcase Permanent and choose Set
active

e With no features selected, click the right-hand mouse button in a blank part of the

active window and select the Contours option to add the contours layer to the
Treeview.




| Attributes

Viewing the Results

Results

Transformation...

Select  entity
Force/Moment
and results
component MX
and click OK
to see  the
results for
Permanent
effects in the
slab.

Analysis: Analysis 1
oadcase: 1:Permanen

Results file: Slab__Design~Analysis 1.mys
Entity: Force/Morment - Thick Plate

Component (Averaged nodal): MX (Units: N.m/m)

11.5393E3
0.0
11.5393E3

Maximum 80.8931E3 at node 18 of element 404
Minimum -22.9607E3 at node 438 of element 191

Wood-Armer Results

Slab design will be carried out based on the Wood-Armer moments in the slab. These
results are computed from the orientation of the reinforcement, so the reinforcement
capacities/details must be defined and assigned to the model before results can be made
available. Two attributes are available from which Wood-Armer moments can be
calculated, and these are accessed from the Attributes > Wood Armer and Attributes >
Design > RC Slab Design menu items. Since we are going to carry out slab design
calculations, we will need to create and assign to the model an RC Slab Design
attribute.

Defining a Results Transformation attribute

A results transformation attribute must be defined and assigned to all surfaces that are
to be designed in order to transform the results according to reinforcement directions.

Assigning Results Transformation attribute

Choose the Global axes option.

Enter the attribute name as Global Transformation and click OK.

Click OK to the message that is displayed.

Select the whole model and drag and drop the Results Transformation attribute

Global Transformation from the & Treeview onto the selected Surfaces.

Click OK to assign the attribute to surfaces.




| Attributes
RC Slab/Wall
Reinforcement. ..

Simple Building Slab Design

Defining the RC Slab/Wall Reinforcement attribute
¢ From the Reinforcement Library select bar sizes to be Metric.

RC Slab/Wall Reinforcement X

e For the Top Face set the bar
sizes as 12mm and set the

Analysis category 2D Grilage/Plate Reinforcement layout

Reirforcement brary

spacing as 100mm in both X = e (e 5 g T Toplayer
g n? Ny
and y’. B RGPy
Top Face -
e R [ ) (1 Jem '.‘dr/;'°
e For the Bottom Face set the Barsiny’ foos Jomm 0 Top layer 2
3 Bottom Face ! |
bar sizes as 12mm apd set the il . | !
spacing as 200mm in both x = = N :
and y’. Reinforcement cover BI 0 |
Eo Top Battom — Wf?/ Botltom layer 2
[[] Use nominal cover in crack with calculations U '@
e Set the T()p and Bottom Nominal cover  Tep |20.0 Batiom 200 mm //
ol O
cover values to be 20. Ofentaton s
Angle of bars in ' from bars in x . i:"; \1 Bottom layer 1
e Ensure the Angle of bars in o T2
y' from bars in x is set to be =
Defaults oK Cancel Apply Help

90 degrees.
e Enter the attribute name to be Slab and click OK.

Assigning the RC slab design attribute

e Select the whole model and drag and drop the RC Slab attribute Slab (T[C=20mm,
DiaX=12mm, DiaY=12mm], B[C=20mm, DiaX=12mm, DiaY=12mm)],
Skew=90) from the &% Treeview onto the selected Surfaces.

Note. Assigning the RC Slab attribute adds a new results entity Wood Armer to the
available results.

e In the Treeview right-
click on Contours and
choose Properties

=

o Set the Entity as Wood- lmmsossss s S
Armer and Component as
MX(B), click OK to close
the dialog and plot the
contours
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| Design

Viewing the Results

Design

Combinations...

Defining Load Combinations

Loadcases will be combined to provide the most adverse loading effects. Different
combination types are required in preparation for the RC Slab Design. This is achieved
using the Design Combination facility within LUSAS Modeller.

Combinations will be provided to EN1990:2002 for ULS Fundamental combination
(using equation 6.10), SLS Characteristic combination and SLS Quasi-permanent
combination.

Defining a design combination

From the country list select Europe.

From the Design code list select EN 1990 — 2002 Buildings Recommended
Values.

For the load Permanent set the type as G | Permanent Actions
For the load Variable set the type as Qi B | Imposed: Category B — office areas
Click Next.

On the combinations options page:

Ensure that for ULS the option for Fundamental combination Eq 6.10 is selected.

Ensure that for SLS the options for Characteristic combination and Quasi-
permanent combination are selected.

Ensure that Create an envelope for each combination type is sclected.
For the Add / Replace / Delete Combinations option, ensure Add is enabled.
For the Combination approach, ensure Basic Combination is selected.

Click Finish to generate the design load combinations.

Plotting results for a design combination

From the @ Treeview, select ULS_F_B (Min) with the right-hand mouse button
and pick the Set Active option.

11



Simple Building Slab Design

o Select the  entity
Force/Moment and [ E
results component MX ‘
to combine, applying g%
the Variable factors mx.‘n""u“r;\"riggé‘fé:‘:7\2%214252?'5@%%%‘2?@1(31;bf§i £
based on the minimum
moments in the X

direction. g

)
Moment - Thick Plate
weraged nodal): MX (Units: N.mfm)

X

e Ensure Change
existing drawing

layers to above
component is selected
and click the OK button.

e Click OK to accept the warning that appears.

Caution. Whilst not a problem with this example, note that if you use smart
combinations with ‘derived components’ you may not obtain the expected results. The
online help provides details of such circumstances which you should fully understand
before using this facility. In this worked example, a linear primary component is being
used to create the smart combination from which the Wood-Armer values will be
computed. It will be necessary to carry out design checks using primary components in
both directions (X and Y) to ensure the most onerous combination is found.

Using the RC Slab Design facility

The RC Slab design facility enables calculation of required steel reinforcement areas
for ULS loadcases and calculation of crack widths for SLS loadcases. ULS
reinforcement design is based on calculated Wood-Armer moments whereas crack
width calculations are based on principal moments. The effective depth is computed
from the top and bottom reinforcement bar sizes and covers provided in the RC Slab
attribute.

Caution. This example uses an irregular mesh of thick plate elements and for these
elements the results are output in global directions that, in this case, match the intended
reinforcement directions. In other modelling situations, if the elements in a model are
orientated such that their local axes vary from one another, or if an alternative
coordinate system is required, the results will need to be transformed to a consistent
direction. This can be achieved by either setting a local coordinate set or choosing an
appropriate results transformation option on a results layer property dialog prior to
opening the RC Slab Designer.

12



| Design
RC Slab/MWall
Design...
| Attributes
| Design >
RC Slab/MWall
Design...
| Design

RC Slab/Wall Design
Results...

Viewing the Results

e FEnsure that Europe (Eurocode | REslabAWsllDesign X
recommended values) and EN 1992-1- | couy Europe (Eurocode recommended values) v
1:2004 are selected from the dropdown list | cesigness=  enissarioon s
of countries and design codes

Fartial factors for matenials

. . Concrete (yc)
e Accept all other settings and click OK.
Reinforeing steel (ys) 1.15
Coefficient for long term effects for concrete
oee
Defaults oK Cancel Help

RC Slab/Wall Design Attribute

e On the General tab select the design calculation method as Bending and in-plane
(Sandwich model / Principal stresses) and click OK to add the design attribute to

the A Treeview.

o In the '2 Treeview right-click on results loadcase Permanent and choose Set
active

e Select the whole model and drag and drop the design attribute Desl from the .
Treeview onto the selected Surfaces.

Note. The Permanent loadcase was set active because a design attribute must be added
to a loadcase and not a combination.

Note. Whilst only the General tab was visited for this example, it is possible to modify
Shear, Min/Max reinforcement, SLS & Creep properties on the other tabs of this
dialog.

Note. For 2D plate models the design calculations options are set to bending only. For
a 3D model comprising shell elements, slab design can be carried out considering in-
plane effects as well as bending.

Adding RC Slab/Wall Design Results

On this dialog, selections can be made to specify which parts of a model should be

checked for which load groups. From the resulting entry in the (X Treeview the design
check results can be viewed, and tables of results can be obtained.

13
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In the Extent panel, select All members. RC Slab/Wall Design Resuts (EN 1292-1-1:2004) X
Extent

In the Design check locations panel ensure = @ ai members

that Averaged nodal is selected. O Visible members
() Group Mone

In the Load Groups panel press the Select O Reinforcement attibute Nane

button for ULS. O Surfaces 1740

Design check locations

On the Select Loadcases dialog presented,
select ULS_F B (Max) and ULS_F B
(Min) and add to the Included list. Click = ;oo™ s

ULS (2 loadcases selected)

Averaged nodal w

SLS - characteristic (2 loadcases selected) Select...
In the Load Groups panel press the Select =~ =5 % pemanen(@ioaicases sclecied
button for SLS — characteristic. Design check rame Load group

ULS (61462 uLs v
On the Select Loadcases dialog presented Minmax reiforcement v
SeleCt SLS C B (Max) and SLS C B 5LS (crack control) check {7.3.4) 5LS - quasipem ~
(Min) and add to the Included list. Click 5L stess Imks (7.2 25 et |
OK Min reinforcement (7.3.2) 5LS - charactenstic |~

Advanced options

In the Load Groups panel press the Select
button for SLS — quasi-permanent. Neme | RC Slab/Wal Design 1 <] ew
On the Select Loadcases dialog presented oK Cancel Apply Help

select add SLS QP B (Max) and
SLS_QP_B (Min) and add to the Included list. Click OK.

On the RC Slab/Wall Design Results dialog accept the default name of RC
Slab/Wall Design 1 and click OK to finish.

An RC Slab/Wall Design loadcase entry 5 named RC Slab/Wall Design 1 will be
added inside a Post processing folder in the (5 Treeview,

Viewing the Results

In the & treeview right-click on the loadcase RC Slab/Wall Design 1 and select
Set Active.

In the =" Treeview double-click on the Contours entry to edit the properties.

Select OK on the warning dialog that appears.

14



Viewing the Results

Component (Averaged nodal): Util(Max)
is set to RC . 1o

Slab/Wall — EN 2 sa0er
1992-1-1:2004 itage

and component set sty
to Util(Max) and

click OK.

: Loadcase: 21:RC Slab/Wall Design 1 (EN19821-1 (E Nod
L] El’lSure that Entlty Entity RG o wal o EN 9055 T 2054 (Europe)l Bodee)

It can be seen that the
maximum utilisation
is 5.386. This will be
investigated further.

e In the @ treeview ri
Show Results

e On the Summary tab click the Util(Max) label at the top of the last column twice
to sort by utilisation value in descending value.

RC Slab/Wall Design Results (EN 1992-1-1:2004) O x
SectionlD: |All ~ SurfacelD: | All i Loadcase: n/a Face/Direction:  n/a lelp
Detailed results for selected row. Display only results for selected surfaces Select surfaces in model Select elements in model

Summary  Enveloped resulls  Section definions  ULS (6.1 6.2) Min-man reinforcement | SLS fcrack control) check (7.3.4)  SLS stress limits (7.2)  Min reinforcemert: (7.3.2)

Section Suface Elemert Node UKI(ULS) Uti(Asmin Asmax) LKI(CC) Lil5L5.5) Uil(AsCC) Ui (Max) ~
I O O O - S T S N TN I
1 3 351 708 5.386 0.723 1952 2570 0.306 | |
1 2 3 708 0.723 2056 2651 0.306 [ |
1 2 323 708 5377 0.723 2056 2651 0.306 [ |
1 1 334 708 5.345 0.723 1945 2582 0.306 535 |
1 4 354 708 5.345 0.723 1.945 2532 0.306 T |
1 1 306 708 4512 0.723 1932 2485 0.308 [ |
1 1 128 708 4512 0.723 1932 2485 0.308 i |
1 4 15; 724 4273 0797 1019 1991 HENY 4977 s

From the summary table it can be seen that:
e The maximum utilisations are due to the Util(ULS) check.
e The Util(CC) and Util(SLS,S) checks also have utilisations greater than 1.0.

These results are to be investigated further by selecting the appropriate tabs.

Viewing detailed results for a slab location

Util(ULS) Check results

e On the main RC Slab/Wall Design Results summary table select the ULS (6.1 &
6.2) tab.

o Expand the width of the table and sort the Util(Max) column in descending order.

It can be seen that the peak values are due to the shear check Util(VRdc).

15
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RC Slab/Wall Design Resuls (EN 1992-1-1:2004) o x
SectoniD: |41 < SufscelD: [ A1 < Loccase: |41 < FacelDirecton: |Al < Help
Detsile results for selected row: Dispiay orly resuls for selected surfaces Select surfaces in madel
Summary Enveloped resuts Section definions  ULS (6.146.2) Min-m: ent  SLS (crack control) check (7.34) LS stress limits (7.2) Min 732
Secton Sufsce Bemert Node Loadosse Face/Diection  Ui(As) Iy UiSe) Uti(/Rde) UiRdmar) s Lti(Max) 2
1 3 351 ) 10ULS F 8-Sy BottomY 0000 [T 0% ]
1 3 m ) SULSFB-& Battom 0000 0000 oser ]
: 5 = = TrEirry | e oom s i
1 3 351 e T0ULS F B -May Topx [P 0473 ]
1 3 351 ) SULS £ B-My Topt 025 0473 ]
: 5 = = SrEaDT = o v o i
1 3 351 ) T0ULS F B -ty Bottomx 0000 0000 0% ]
1 3 351 ) T0ULS F B My Topt 1308 025 0473 .

Util(CC) check results

e On the main RC Slab/Wall Design Results summary table select the SLS (crack
control) check (7.3.4) tab.

o Sort the Util(CW) column in descending order.

RC Slab/Wall Design Results (EN 1992-1-1:2004) o x
SectionlD: Al - SurfacelD: | Al ~ Loadease: | Al ~ Face/Direction: |Al ~ Help
Detailed results for selected row. Display only results for selected surfaces Select surfaces in model Select elements in model

Summary  Enveloped rests Section defintions  ULS (6.18 6.2) Min-max reinforcement  SLS (crack control check (7.34) SLS stress limits (7.2) Min reinforcement (7.3.2)

Section Surface Element Node Loadcase Face/Direction  Eceff [GPa] fs [MPa] W) ~
T e A T T
0 2 ) o 155507 B -5 Toot 109375 061526 2 |
1 2 23 708 19:5LS_QP_B - Mxy TopY 109375 861.924 I
: > 00 0 155L5 0P8 e Teoy tosss | seisae i
1 2 323 08 18:5LS_QP_B - Mx TopY 10.9375 861.924 I
1 2 304 708 18:SLS_QP_B - My TopY 109375 861.924 I
: > 00 0 1851507 8-Sy Teoy tosss | seisae i
1 2 323 708 19:5L5_QP_B - Sx TopY 109375 861.924 I
1 11 0 19:61S 0P B .My I 109375 61924 | | hd

Investigating Util(CC) results further

e Select the first row in the SLS crack control check table and then click the Detailed
results for selected row button at the top of the dialog. Double clicking the row
will also give the detailed results.

e In the Design Calculation Viewer select the SLS (crack control) check (7.3.4) and
scroll through the results to view data relating to the Utilisation being exceeded.
This will be highlighted by red text — there are two instances of this in this check.

From the calculations it can be seen that the utilisation exceeds 1.0 in both the x and y
directions.

e Close the Design Calculation Viewer.

Util(SLS,S) check results

e On the main RC Slab/Wall Design Results summary table select the SLS stress
limits (7.2) tab.

e Sort the Util(Max) column in descending order.

The maximum utilisation is due to the check on Util(sigmaS).
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Viewing the Results

S0 Surcad pr— fS—
| Detsled resuls forseectedrow || Disp = | s | | Selectlemerts inmoel |

Summary Enveloped resuts  Section defintions ULS (614 6.2) Minmax reinforoement  SLS (crack control) check (7.3.4) LS stress lmits (7.2) | Min reinforcement (7.3.2)

Section Surface Element Node Face/Direction  Eceff [GPa] Lti(sigma S) UtilfsigmaC) Uil(Max) l
1 2 375 265
1 2 B e e s Tony 05375 2651 oo 2t
1 2z 304 708 15:5LS_C B - Sx TopY 10.9375 2651 0.000 2651 .
1 2 kv 708 15:5LS_C_B-Sx TopY 10.9375 2651 0.000 2651 .
1 2 ) e T5st5.c.8-hy Tonv 10537 2651 oo o |
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e Close the RC Slab/Wall Design Results.

Viewing the contour plots

The contour plots for the results of interest will now be viewed. This is best done using
the Design contours option that shows values of utilisation from 0.7 to 1.0 and above.

e In the =¥ Treeview double-click on the contours layer.

o Ensure the Entity is set to RC Slab/Wall — EN 1992-1-1:2004 and the component
is set to Util(Max).

e Select the Appearance tab and select the Design option. Press OK.
The contour plot is as shown below.

Loadcase: 21:RC Slab/Wall Design 1 (EN1992-1-1 (Europe) | Nodes)
Entity: RC Slab/Wall - EN 1992-1-1:2004
Component (Averaged nodal): Util(Max)

Maximum 5 38596 at node 18 of element 404
Minimum 0.722754 at node 4 of element 115

Similarly the plots of interest for Util(ULS), Util(CC) and Util(SLS,S) follow:
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Util(ULS)

Loadcase: 21:RC Slab/Wall Design 1 (EN1992-1-1 (Europe) | Nodes)
Entity: RC Slab/Wall - EN 1992-1-1:2004
Component (Averaged nodal): Util(ULS)
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util(cc)

Loadcase: 21:RC Slab/Wall Design 1 (EN1992-1-1 (Europe) | Nodes)
Entity: RC Slab/Wall - EN 1992-1-1:2004
Component (Averaged nodal): Util(CC)

0.7
e

0.9
1
Maximum 2 05619 at node 18 of element 289
Minimum 7.00426E-3 at node 1145 of element 425
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ULil(SLS,S)

Loadcase: 21:RC Slab/Wall Deslgn 1 (EN1 992141 (Eurupe] | Nodes)
Entity: RC Slab/Wall - EN 1992-1-1:2
Component (Averaged nodal): UhI(SLS S|

= nﬁa
09
1.0

Maximum 2 65072 at node 18 of element 289
Minimum 0.0122267 atnode 1145 of element 425

Further contour plots are available which can provide additional information. For
example the plot of Util(CC) can be separated into top and bottom checks, Util(CC(T)
and Util(CC(B)) receptively as shown below.

util(cc(T)

Loadcase: 21:RC Slab/Wall Design 1 (EN1992 -1-1 (Europe) | Nodes)
Entity: RC Slab/Wall - EN 1992-1-1:2004
Component (Averaged nodal): Util(CC(T))

0.7
o5
0.9
1.0

Maximum 2 05619 at node 18 of element 289
Minimum 0.0 at node 6 of element 115
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Util(CC(B))

Loadcase: 21:RC Slab/Wall Design 1 (EN1992-1-1 (Europe) | Nodes)
Entity: RC Slab/Wall - EN 1992-1-1:2004
Component (Averaged nedal): Util(CC(B))

Maximum 1 63847 at node 509 of element 237
Minimum 0.0 at node 2 of element 102

From this it can be seen that the Util(CC(T)) is critical over the central column support
while Util(CC(B)) is critical in the span near the right hand edge of the slab.

Notes regarding utilisations obtained

The objective of this example is to demonstrate the use of the RC slab/wall design
facility. To this end the modelling of the structure has been somewhat simplified.

A more accurate model could be considered by the inclusion of details such as column
heads or drop panels as necessary. Also, the modelling approach could be developed to
include the columns themselves or to provide constraint equations to reflect behaviour
more accurately at the head of the column.

In addition, the plate/shell elements in LUSAS are high performance. Therefore, the
effects of stress concentration may be considerable, as is the case in this example. As
with any finite element software, engineering judgement should be applied when
analysing the results.

As a result of this there are very high utilisations at and around the support locations.
Whilst some increase to the area of reinforcement is required to particular regions the
previous comments should be noted when considering the reinforcement requirements
near the supports.
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Save the model

El Save the model file.

Note. All the Slab Designer inputs are saved to the model and will be saved when the
model is saved. All load combinations, envelopes, and graph datasets, if defined when
processing results, are also saved and therefore do not have to be re-created if the
model is amended and a re-analysis is done at a later date.

This completes the example.

Element types and orientation of results

The orientation of the slab reinforcement is aligned with the results axes. In this
example thick plate elements are used whose results axes are always transformed to the
global directions.

Caution. If shell elements are used (when they may be appropriate) the results must
be transformed into a consistent direction coinciding with the intended direction of the
reinforcement. Note that by default shell results are orientated along the local element

axes.

e The mesh orientation can be viewed from the Treeview by selecting Mesh >
Properties and selecting the Show Element Axis option. Press OK to apply
changes.

e Results transformations can be applied using the Transform Set... button on a
results layer’s Properties dialog. Selecting Global axes will transform local element
results into the global axes system. Other options are available.

o Global results are indicated by the uppercase X, Y and Z in the component names,
whereas lowercase x, y and z (when seen) are used to denote local results or
transformed results.

Element density and resuilts obtained

If the Teaching and Training version of LUSAS was used to carry out this example
with a reduced default mesh density of 4 divisions per line a reduced accuracy of
results will be obtained.

In general, more accurate results are obtained when using more line mesh divisions and
hence more elements when modelling slabs of this type. Care should always be taken to
use an appropriate number of elements together with a possible refinement of the mesh
in areas of interest in order to obtain the best results.
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